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/\ CAUTION

Do not drink the liquids under any circumstances,
as they can cause vomiting and diarrhea.

Take care not to let the liquids come into contact
with your eyes or onto your skin,

otherwise inflammation can result.

/A ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten,

da die Gefahr von Erbrechen und

Durchfall besteht. Vermeiden Sie den Kontakt
der Flussigkeiten mit Augen und Haut,

sonst kdnnen diese gereizt werden.

/\ ATTENTION

Ne pas avaler les liquides d'aucune maniere,

car ceci pourrait entrainer vomissements et diarrhée.
Veuillez & ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,

car ceci pourrait entrainer une inflammation

A\ ATENCION

No tome los liquidos en cualquier caso,

como pueden causar vomitar y diarrea.

Tome el cuidado para no permitir que los liquidos
toquen los ojos ni en la piel,

de otro modo inflamacién puede resultar.

A\ ATTENZIONE

Non bere per nessun motivo i liquidi poiché
possono causare vomito e diarrea.

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.

/A WARNUNG
Teile in Bewegung.
Sg Halten Sie Finger und andere
Kérperteile auf Abstand.
ANE S /\ AVERTISSEMENT
OERERfEER,

Piéces mobiles dangereuses.
FPEEEIIRNE,

Eloignez les doigts et autres
ANE &
=

parties du corps.

/\ ADVERTENCIA

hEFE AR B - Partes peligrosas en movimiento.
FHNERARER. Por favor, mantengase alejado.

A WARNING

Hazardous moving parts.

A\ AVVERTENZA

Attenzione parti in movimento.
Keep fingers and other body Tenere le dita e altre parti del
parts away. corpo lontane.
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A GEFAHR

A DANGER

Hazardous voltage will | Hochspannung verletzungsgefahr! [Un voltage non adapte provoque| Un voltaje inadecuado puede

switch and wait 5minutes |aus und warten sie 5 minuten,

A DANGER

cause injury. Turn off main| Bitte schalten sie den hauptschalter | des blessures. Eteindre
linterrupteur et attendre 5
before opening this cover.| bevor sie diese abdeckung &ffnen. [minutes avantd'ouvrir le capot. | minutos antes de abrir esta cubierta

a5, RSB
5 S, BRAHE.

A PELIGRO

provocar las heridas. Apagar el
interruptor principal y esperar 5

m—
/\ ATENCION

No se suba encima de la impresora.

I /A CAUTION
[

A\ ATTENZIONE
Do not climb onto the printer. Non salire sulla
A\ ACHTUNG AEE
Niemals auf den Drucker steigen. FEOLCESBNIE,

A\ ATTENTION AZEE

Ne montez pas sur limprimante. WL LE.

7
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8 /A CAUTION F B

Take care not to let the liquids come into contact with
your eyes or onto your skin,
otherwise inflammation can result.

A
-
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A\ ACHTUNG

BATRES | RAE.
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Vermeiden Sie den Kontakt der Flissigkeiten mit
Augen und Haut, sonst kénnen diese gereizt werden.

/\ ATTENTION

Veuillez & ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation.

A\ ATENCION

Tome el cuidado para no permitir que los liquidos
toquen los ojos ni en la piel,
de otro modo inflamacién puede resultar.

/A ATTENZIONE

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.
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/\ CAUTION

Moving platen, T-shirt tray and covers can cause bodily injury. Keep hands off platen while printing.

/\ ACHTUNG

Halten Sie die Hander von der Auflage wahrend des Druckvorganges fern

Druckplatte, T-Shirt-Ablage und Abdeckungen konnen kérperliche Verletzungen verursachen.

/\ ATTENTION

Déplacement du plateau, chargeur T-shirt et couvercle peut blesser le corps.
Garder les mains éloignées lors de limpression.

/\ ATENCION

Retire las manos de la placa durante la impresion.

Moviendo la placa, la bandeja de camiseta y las cubiertas pueden causar una herida personal.

A\ ATTENZIONE

Tavoletta mobile, il ripiano per la T-shirt ed il carter potrebbero causare infortuni
Tenere le mani lontane dalla tavoletta durante la stampa.
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A\ CAUTION

Do not drink the liquids under any circumstances, as they can cause
vomiting and diarrhea. Take care not to let the liquids come into contact
with your eyes or onto your skin, otherwise inflammation can result.
Keep the liquids out of the reach of children.

A ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten, da die Gefahr von Erbrechen und
Durchfall besteht. Vermeiden Sie den Kontakt der Flassigkeiten mit Augen
und Haut, sonst konnen diese gereizt werden. Halten Sie die Flssigkeiten

von Kindern fern.
A ATTENTION

Ne pas avaler les liquides d'aucune maniére, car ceci pourrait entrainer
vomissements et diarrhée. Veuillez & ne pas laisser ces liquides étre en
contact avec les yeux ou la peau, car ceci pourrait entrainer une
inflammation. Maintenez les liquides hors de portée des enfants.

A\ ATENCION

No tome los liquidos en cualquier caso, como pueden causar vomitar y
diarrea. Tome el cuidado para no permitir que los liquidos toquen los ojos
nien la piel, de otro modo inflamacion puede resultar. Mantenga los
liquidos fuera del alcance de nifios.

A\ ATTENZIONE

Non bere per nessun motivo | liquidi poiché possono causare vomito e
diarrea. Evitare il contatto di questi liquidi con gli occhi e con la pelle poiché
potrebbero creare infiammazioni. Conservare | liquidi lontano dalla portata

dei bambini.

WO ESCE S TRERU TS0, B SRR SRR,

W Deposite in compliance with your local regulations.

W Gebrauchte es gemaB ortlichen Richtlinien entsorgen

1 Jotez conformément a a eglementalion locale en vigueur.
W Deseche siguiendo la normativa loc:

B Sarire in Somvonmita o nanmetive iocal,

A\ CAUTION

Do not drin and diarthea
Tk care not to I the liquics come ino conact with your yes of 0T your sk
f the reach of chilgren.

A\ ACHTUNG

Bitte trinken Sie nicht die Flissigkeiten, da die Gefahr von Erbrechen und Durchfall
besteht. Vermeiden Sie den Kontakt der Flissigkeiten mit Augen und Haut, sonst
rden. Halten Kindern fern

N ATTENTION

Ne pas avaler les liquides d'aucune mai ar ceci pourrait entrainer
vomissements et diarrhée. Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau, car ceci pourrzit entrainer une inflammation
Maintenez les liquides hors de portée des enfants:

/N ATENCION

No tome los liquidos en cualquier caso, como pueden causar vomitar y diarrea. Tome el
cuidado para no pemiti que los liquidos toguen los ojos i en la piel, de otro modo
inflam

W Deposite in compliance with your local regulations.
W Gebrauchte es gema ortlichen Richtlinien entsorgen.
=

' Deseche siguiendo la normativa local.

A\ ATTENZIONE

Non bere per
Euitare il contatto di questi liquidi con gli occhi e con la pelle poiché potrebbero
creare infiammazioni. Conservare i liquidi lontano dalla portata dei bambin
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A\ CAUTION

BICASIDEBICO<E, | B AR HIRE E,
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GREASE BABVIE, LZEGH

Lubricating grease may cause Inflammation to eye and skin.
Wear protective glasses and gloves.

Swallowing grease can cause diarrhoea and vomiting.

Do not swallow.

A\ CAUTION

Do not drink the liquids under any circumstances,
as they can cause vomiting and diarrhea.

Take care not to let the liquids come into contact
with your eyes or onto your skin,

otherwise inflammation can result.

Keep the liquids out of the reach of children.

/A ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten,

da die Gefahr von Erbrechen und Durchfall besteht.
Vermeiden Sie den Kontakt der Flussigkeiten mit
Augen und Haut, sonst kénnen diese gereizt werden.
Halten Sie die Flussigkeiten von Kindern fern.

A\ ATTENTION

Ne pas avaler les liquides d'aucune maniere,

car ceci pourrait entrainer vomissements et diarrhée.
Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau, car ceci pourrait entrainer
une inflammation.

Maintenez les liquides hors de portée des enfants.

/A\ ATENCION

No tome los liquidos en cualquier caso,

como pueden causar vomitar y diarrea.

Tome el cuidado para no permitir que los liquidos
toquen los ojos ni en la piel,

de otro modo inflamacién puede resultar.
Mantenga los liquidos fuera del alcance de nifios.

/\ ATTENZIONE

Non bere per nessun motivo i liquidi poiché
possono causare vomito e diarrea.

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.
Conservare i liquidi lontano dalla portata dei bambini.
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W Deposite in compliance with your local regulations.
Gebrauchte es gemas ortlichen Richtlinien entsorgen.
M Jetez conformément a la reglementation locale en vigueur.
W Deseche siguiendo la normativa local.
Smaltire in conformita alle normative locali.
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5-3-1. {#iF] CorelDRAW i}

T, WHPATLLU N ERE.
o PFitINE
o FTEIRGY
VAR T AT DL A
o BUEATENEHE (ARXP 30
o HFHSEAEM IR
o HHNNIE
o KK RGB=255 ¥y RGB=254

[%£]
o AHLFHEFTF CorelDRAW 2018/2019, it CorelDRAW 2019 13 BH /< Hi [fi o

e EH R E
(1)  MSEHAF:Fi%#Tools]>[Color Management].
(2) [Color Management Settings]i#f17 A 15 & .

e [RGB profile]: [sRGB IEC61966-2.1]

e [Primary color mode]: [RGB]
¢ [Rendering intent]: [Relative colorimetric]

Color Management Settings X
Default
~
Preset: | Custom i E
RGB profile: | (Default) sSRGB IEC61966-2.1 -
CMYK profile: | (Default) U.S. Web Coated (SWOP) v2 v
Grayscale profile: | (Default) Dot Gain 20% -
Primary color mode: | RGB =

Rendering intent: ‘ Relative colorimetric

Color conversion
Color engine: | Microsoft ICM CMM >

Preserve pure black
v| Map gray to CMYK black

? oK Cancel
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FTERR

(1)  MEEA R IEREFile]>[Print].

(2) ¥[Printer]#% & N'"Brother GTX PRO"z{"Brother GTX PRO FileOutput" 1 T & —ANit
THHE.
(%]

o ¥f[Printer] % & A"Brother GTX PRO ", TEPRTENEHE K% 4T ENHL.
#[Printer] % & 4"Brother GTX PRO FileOutput"it}, #TENRHTEN¥E L ARXP SCHHRAT

sti[Apply], KH[Printpxf

Print X
General Color Composite Layout Prepress PostScript No Issues
Destination
Printer: Brother GTX pro v ‘ {:}
Orientation: | Match orientation (Letter, Portrait) v
Status:
Location:
Comment: Single File ~
Print range Copies
® Current document Documents Number of copies: 1 =
Current page Selection
1 GMCAH
Print as bitmap: 300 dpi
Print style: CorelDRAW Defaults o Save As...
—
? Print Preview » Print Cancel Apply
L )

(3) MEHA:rhik#Layout]>[Page Layout].
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(4) [Page SizelitfTLA Nk E.
[Size]: [Custom]
[Width]: 355.6 2K
e [Height]: 406.4 =X
o ITEIRIJTIA: ZhIF)

o CRREEEAEEEBE NIRRT . EIAURAER] 14%16 RIS =7"5-4-1. AR >>P.83"

Document Options

General
Page Size
Layout
Background
Guidelines
Grid

Rulers

Save

? Save as Default...

® Page size Label presets

Size and orientation

Sizel Custom i [~ i) I
Width@§ 355.6 ~ | millimeters >
Heightfl 406.4 110l o

Apply size to current page only
v| Show page border

Add Page Frame

Rendering resolution: ~ | dpi

Bleed: |4.0 -

Show bleed area

oK

Cancel

X
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BIEATENEEE (ARXP 30f4)

LA ARXP 12 0Hs FUR B AT BB E A A AT BN (A7
Az B ARXP SCAFE T DLEAT AR #4
o WLURHEMEEUEATEN R B S B AN IR AT
o TWLIANESRL PC W USB f#fifias EAZFTHL.
(%]
o ARXP MATEGEEIE . TEESR EGEHE R ] .
o IEHNHRREFHESIPrint to file]it & R RETCIATEE S ST AL LAY R A . T I T ENFLIRENRE S Brother GTX
PRO FileOutput".
o NIRRT EAEFAT NSRBI ="6-6-2. IS HIFR T RIEHT Eids >>P.142"

(1)  MEEA= A iEFEFile] >[Print].

(2) FIJF[Colorlbr%s, HATLATE.
e ik [Document color]
e  [Color conversions]: "Brother GTX PRO"&}"Brother GTX PRO FileOutput"
e [Color profile]: [sRGB IEC61966-2.1]
¢ [Rendering intent]: [Relative colorimetric]
Print X
General = Color = Composite = Layout = Prepress = 1lssue

Color: ® Composite
Separations

Settings: ® Document coior

Color proof
Color conversions: Brother GTX pro FileQutput v
Color profile: sRGB IEC61966-2.1 v

V| Preserve pure black

Rendering intent: Relative colorimetric v

The color settings and preview available in this dialog box are set for the Windows
Graphic device printer that you selected on the General tab.

? Print Preview » Print Cancel Apply

(3) FTJF[Generallkr%s, M[Printer] ik 44 FH "Brother GTX PRO FileOutput”,
(%]
o IR EXZIN[Printer]iX & N"Brother GTX PRO "I, T EN#E KX ZEATEIHL.
B8 2 X R A[Printer] i3 & 4"Brother GTX PRO FileOutput"if, $TEI%E L ARXP SUH{RAF .

(4) fE[Preferences] it BT EIHLIRENIEFF . ="6-4. WETTEMHLIRREFF >>P.81"
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(5) % F[PrintpHEHERI[OK] G, B s FAFENE. AR

[Z*%]
o THETREJLMHHYIN A
9’ Brother GTX pro File OutputFi:SEE o %
58 MG_1404 7.0
IR 13/02/2020 15:06 A
EWRRT 14x16
SRR : YR+asne
= 5
o 3
$TENRSiA: x 10
B2 hRER: 400 %
FARHNRE: off
FENRARGTED: off
...
VERE: 0.06 cc Tz >
aEhE: 0.20 cc 100% } ! 0 ! ! ! 600%
$TED: 13k ! ' ’ ' ' !
L S 1 W+eMYK  v| [T B2sdR
- = e =

(6) FHEIRFAAEIDCIFA], [RAFIARXP LA

A5 I SE B e R it

(1) HIREIHER, F CorelDRAW I i 30" GT_Colors.xml"FI"GT_Tshirts xml"{if7 % PC 1,
(2) MeEsfishkEEWindow] >[Color Palettes] >[Open Palette].

(3) &4 "GT_Colors.xml"FI"GT_Tshirts.xml".

(%]
o IHZMEH HKS. Pantone SFIBIEAFEA ARSI . 75U AT BN FTREAN A .
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BN
(1)  MEEA %S [Bitmaps]>[Convert To Bitmap].
(2) *#[Color mode]# & N[RGB Color].
(%]
o (EFAMERITENN, K[Anti-aliasing] i) R IEHERH %S .
Convert To Bitmap X

Resolution: | 300 ~ | dpi

RGB Color (24-bit) -

Options
| Anti-aliasing
/| Transparent background

Uncompressed file size: 8.33 MB

? OK Cancel

[Z%]
o RMEAITERHLERSIFE T HIE R IR T, [Page Layout] - AT §EAS [Settings from printer].
G AR RS E[Page Layout] B ek e Al e
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¥ebr B i) RGB=255 ##:y RGB=254

RGB=255 5 uiZ i th. f 7 RGB=255 [/ At i 55 .

ITENA LY, 5% RGB=255 X ) & RGB=254.

T LA v T B e

(1) MEEEA 1k %[Effects]>[Adjust]>[Replace Colors].

(2) A[OId color]) Fi3E ., 7E[Replace Colors]Hii% & iy RGB=255.

Replace Colors x

s
(3) HHFERER 244 [New color]# &y RGB=254.
(4) *¥[Range]itE A"", mAE[OK]#4L.
Replace Colors X

Qdeclor: ]| +| A

New color: -| A

Options: Ignore grayscal

Single destinat I
Difference Between Colors

Hue: -
Saturation: 0 =
Lightnes: o |2
eng K 8

(%]
o REHUEN, WERIRAHIEENCN RGB=254.
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5-3-2. f#F] Adobe Photoshop i

AT B A

©00000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

H LT Photoshop $14TPA /%
o FiE
VAR T AT DL A
o BUEEFTENHUE (ARXP )
o fHEAR
o J4"RGB=255"# 1 N"RGB=254"

(%]

o BN CMYKHET, it ISR ik Image] >[Modelf4#y RGB #.#(sRGB). @it =% HA~ 1 f¥[Image] >[Adjustments] P ]

SRS, BUEEHT MRS R P (M (="5-4-9. I EmR >>P.94") fiEE.
o RHLHHEFEM A Photoshop CC2020/CC2019. ifid Photoshop CC2020 it FH ERIE [H] -

BB
(1) MR IEFREdit] >[Color Settings].

(2) [Color Settings]i?Hf7LL Nk HE.
[Working Spaces]
¢ [RGB]: [sRGB IEC61966-2.1]
[Conversion Options]
e [Engine]: [Adobe(ACE)]
e [Intent]: [Relative Colorimetric]
[Color Management Policies]
e [RGB]: [Convertto Working RGB]
e [CMYK]: [Convertto Working CMYK]
e [Gray]: [Convertto Working Gray]

e  [Profile Mismatches]: %" [Ask When Opening]. %+ [Ask When Pasting]

e  [Missing Profiles]: i£H[Ask When Opening]

Color Settings

Settings:  Custom
Working Spaces
RGB: sRGB IEC61966-2.1
apan Color 2011 Coated
Dot Gain 15%

Spot: Dot Gain 15%

Color Management Policies
RGB: Convert to Working RGB
rking CMYK
Norking Gray
& Ask When Pasting

sk When Opening

es: @ Ask When Opening

Description

Conversion Options
Engine: Adobe (ACE)
Intent:  Relative Colorimetric

2 Use Black Point Compensation

2 Use Dither (8-bit/channel images)

2 Compensate for Scene-referred Profiles

Advanced Controls
Desaturate Monitor Colors By:
Blend RGB Colors Using Gamma:

Blend Text Colors Using Gamma:
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BIATENSE (ARXP 304
LA ARXP 12 0Hs FUR B AT BB E A A AT BN (A7
Az B ARXP SCAFE T DLEAT AR #4
o WLURHEMEEUEATEN R B S B AN IR AT
o TWLIANESRL PC W USB f#fifias EAZFTHL.
(%]
o ARXP MATEGEEIE . TEESR EGEHE R ] .
o IEHNHRREFHESIPrint to file]it & R RETCIATEE S ST AL LAY R A . T I T ENFLIRENRE S Brother GTX
PRO FileOutput".
o MBFIFEF EIEMFTENUAOE BRI ="6-6-2. MR FIFRT RIXITENEdE >>P.142"

(1) Mg REFile]>[Print]l. PC —f&fd 4T EVHL A "Brother GTX PRO"EZ"Brother GTX PRO FileOutput", #
BB AR RT
(2) FATLATHE.
e [Color Handling]: [Printer Manages Colors]

e [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings X

Printer Setup
Printer:  Brother GTX4 FileOutput

Copies: 1 Print Settings...

Layout: n &1

Color Management

Printer Profile:
Normal Printing

Rendering Intent:  Relative Colorimetric

Description

Position and Size

(3) M[Printer]Fi%&F 444 3 "Brother GTX PRO FileOutput".
(%]
o ¥4[Printer] i3 & N"Brother GTX PRO ", ITEIHE AL EITEIHL.
#[Printer] 15 & N"Brother GTX PRO FileOutput"if, FTEN4E L ARXP SCAFRAE

(4) fE[Print Settings] i E 1T EIHLIRENERF . ="56-4. BESTENHIIKSIFER >>P.81"
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(5) F R[Print]J Eom A RAHEHE. s [RAF].

(6)

(%]
o IRETEJ LA BRIRTTA .

W Brother GTX pro File OutputFi:aEE

#54a:
EIngedia):

E®RRT:

SHEELR

=

o

$TENAYIE):

BERER:
FREHNRES:
FBMRSHRGIT:

V...
FEHE:

B2nhE:
FTED:

MG_1404
13/02/2020 15:06

14x16

Ye+asne

5

3

x10
400 %
off

0.06 cc
0.20 cc
13k

AT B A

< >

100% | 600%

L 5] 1 W+CMYK v T Besin
e e |

RERIFEIRCAEAA], [RAFIARXP XA
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A5 FA S A AP B AR B
(1) FEEERFER, K Photoshop FIA b SCf4-"GT_Colors_T.ase"f#:47 % PC .

(
(

2) MERER % [Window] >[Swatches].
3) mii=, fIHFEHE.

Swatches

Eim H
m

o meyT

(%]

RGB=254

B2 HKS. Pantone SEIBEAEA tbR PRSI 753 Ui A T BN T REAN ] o
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BT BN
¥ RGB=255 &ty RGB=254 i}
RGB=255 iHANiEA L, 78 RGB=255 [fIH4: ANt il as
ITEN i, 1514 RGB=255 [ [X 18- & # i RGB=254.
T DU R 7537 B e
(1) i SEHAR i [Layer]>[New Adjustment Layer]>[Selective Color] |75 & 2.
(2) BAEWEBEN 20%7 5 3[0K].

Cancel

Color: None

Mode: Normal Opacity: 20|

(3) fE[Selective Color]F#f1TLA Nk HE.
e [Colors]: [Whites]
e [Black]: 1%
e iEH[Absolute]

Properties

m u Selective Color

Custom

S: - Whites

Relative © Absolute

[Z%]
o W EFTR, ¥ RGB=255 &4y RGB=254 [1]/5i%, {¥[Color mode’N[RGB Color]f#[8 bit]i T .
e jBiT Photoshop ¥ RGB=255 & &y RGB=254 Hzh{E 3 {f"SolidWhite.atn"/ESL 4 (=5-5-2. #4"RGB=255"## 4y
"RGB=254" ({X Photoshop) >>P.97"RGB=255"##i:’A"RGB=254" ({{ Photoshop) >>P.97"RGB=255"# 1. 4"RGB=254" ({{
Photoshop) >>P.109"). KT %, &SR Photoshop F3EH).
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5-3-3. f#iF Adobe lllustrator i

THIEL Nustrator 447 LN A
o PihNE
o FTIFECH

AR 75 AT A T
o BUEATEREE (ARXP 30
o [EHSAHEM A B R

(%]
o bR EUEBHEAESTENVEE, EUGHER KGR, T ME—#RAE.
- JASIETEE PC —fs A AT DKL B N"Brother GTX PRO"EL"Brother GTX PRO FileOutput".
- jE;g"Brother GTX PRO FileOutput"+T EUH LRSI 46 H Sk T A .
o BB HNCMYKIH, iE# K432\ Photoshop, i@id 3 Hi i () [Image] >[Mode] #4454 RGB 1. % (sRGB). 734+, i 2 \ Photoshop
DA P gm e S BB T EPH LIRS AR P R G (='54-9. R EER >>P.94") iR .
o AHLHHEEE llustrator CC2020/CC2019. @it llustrator CC2020 i B onH i -
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[RERz AN
(1) MR IEFEEdit] >[Color Settings].
(2) Ai[More Options].

(3) 4T FrE T B E I R [OK].
e  [Settings]: [Custom]
[Working Spaces]
e [RGB]: [sRGB IEC61966-2.1]
[Color Management Policies]
e [RGB]: [Convertto Working Space]
e [CMYK]: [Convertto Working Space]
e  [Profile Mismatches]: %" [Ask When Opening]. %+ [Ask When Pasting]
e  [Missing profiles]: i%H1[Ask When Opening]
[Conversion Options]
e [Engine]: [Adobe(ACE)]
e [Intent]: [Relative Colorimetric]

Color Settings

}: SRGB IEC61966-2.1

MYK: U.S. Web Coated (SWOP) v2

Policies
RGB: Convert to Working Space
MYK: Convert to Working Space

- B Ask When Opening Ask When Pasting
: 4 Ask When Opening

tent:  Relative Colorimetric

[ Use Black Point Compensation

Less Options
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ITTFHCAF

(1) BEFCR.
e [Width]: 355.6 =X
e [Height]: 406.4 ZX
e [Orientation]: #[]
e [Color mode]: [RGB]
(%]
o CHIEEMEERENEHIERRS . (5"5-4-1. EERRRST >>P.83") i AFFHER] 14%16 FARMI R .

More Settings

lame: Untitled-1
[Custom]

ol 1

ize: [Custom]

355.6 mm Units:  Millimeters

406.4 mm Orientation: [g] [&

Top Jottom oft Right
A n _ ~ ~ - Paem==
C 0omm ° ° C 0omm

: RGB
cts: High (300 ppi)

e: Default

Templates... Create Document

77



oooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooooo

BIEATENEEE (ARXP 30f4)

LA ARXP 12 0Hs FUR B AT BB E A A AT BN (A7
Az B ARXP SCAFE T DLEAT AR #4
o WLURHEMEEUEATEN R B S B AN IR AT
o HLUIANESE PC M USB f7fifids ELEEATENL.
(%]
o ARXP MATEGEEIE . TEESR EGEHE R ] .
o IENHNRREHERIPrint to file]it & AT RETCIEERE SISO AL B AN R A
PRO FileOutput".
o MBFIFEF EIEMFTENUAOE BRI ="6-6-2. MR FIFRT RIXITENEdE >>P.142"

(1) MR EEE[File] >[Print]>[Color Management].
(2) BHATLLT WA

e  [Document Profile]: [sRGB IEC61966-2.1]

e [Color Handling]: [Let lllustrator determine colors]

e  [Printer Profile]: [sRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

AT B A

oooooooooooooooooooooooooooooooo

T FT LK ENFE 7" Brother GTX

Print

Print Preset: Custom

Printer: Brother GTX pro FleOutput

General

Marks and Bleed
Output

Graphics

IEC61966-2.1

llustrator determine colors

Color Management

file: sRGB IEC61966-2.1

t: | Relative Colorimetric
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(3) MIPrinter]rfid 44 H H"Brother GTX PRO FileOutput”.

(%]

o ¥4[Printer] i3 & N"Brother GTX PRO ", ITEIHE AL EFTEIHL.
#[Printer] ¥ & 4"Brother GTX PRO FileOutput"fis, FTEI%E L ARXP SCH-RAT

(4) 7E[Advanced] i BATEINLIRANIET . ="5-4. WEATHINLIREIIET >>P.81"

| GE=9

o Adobe lllustrator Itf, iR FIAREFIATHT B EHE A OARTK AUAS BEELIAR T ANFTEN EXHEHE B B, W] RETCIE I

BERERSAE.

(5) #% F[Print]/5 R LA R XHEHE. s [PR1].

(%]
o AIRETEJ LA BREITTA .

& Brother GTX pro File OutputFi:SEE

#5a: IMG_1404
BN 13/02/2020 15:06
E®RRT: 14x16
SR : Ye+asne

= 5

¥ 3

$TENRYiA: x 10

B2 hRER: 400 %
FRREHDRE: off
FEMEARRGTED: off
PERE: 0.06 cc
B2hE: 0.20 cc
$TED: 13

1#7F BUH

< >

' ' ' . '
100% _l} ; . 600%

BTE 1 W+CMYK | [T 28R
e = |

(6) FHEIRMAAEICIEA], [IRAFIARXP SCA-
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A3 P S A A o B R

(1) I e, B llustrator F G SCf4"GT_Colors_T.ase"{#/7 % PC .
(2) MEEF:RiEFWindow] >[Swatches].

(3) Miili=, i&¥ ¥ [Open Swatch Library].

(4) E&FF[Other Library].

Swatches

n

Exm N
m

amyr

(5) 7E[Openliifiirhi%#% 3 44:"GT_Colors_T.ase".
(%]
o %5 Photoshop Fil CorelDRAW [, 5 BEERRAFT S FT %%
{EAE, A NlustratorCC I, Jlid DL R 753k E bk, SRS I AT LLE 3R R.
MRS PSS, TSR E].

GT_Colors_T Add to Swatches

Jo Sort by Name
LA A A/ Sort by Kind
Show Find Field

Small Thumbnail View

L‘LL‘LLL

!‘—-“"“‘
N NN

A/
4 4
4V
4 4
Wil
4 4

Medium Thumbnail View
Large Thumbnail View
Small List View
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54. WEITEWURSIET

e« GTXPRO TETHLEEEIRFF# RGB=(255,255,255)1F "% ] amab B, 7RIk i 5. ARTHER] (5 6o i B TED R At Er OB, 75
% E H RGB=(254,254,254).

o ETHMBETE AR SRR (5753, MBS >>P63") B R I .

(1) $EESHFRFFRFTEIEE, BondTEINLIREIARE - HIFT Bis B X 1 HE

| & nEEER X

Ex/Ee ETRE
[ERRT: 14x16 v G E
Bl 552> FE+oene v
et (OFLES (@]=]--H::1 L1F:3
Beh8iGE: 1 3 5 7 9
\ e I 5
1 2 3 4 5
A I 3
FTEMERIE: | .1 E&ﬂ [ 400 %
O aems#TEN
O a&nixiTen [_
Oaesed4Ten [__
OfREMSRe(RETIEER
O# ety 8 SRBEFTEN REREE
HRE:
SETHHMRE,
=
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(2) AT EPHLIRBIRE 7 HO4T BNV B HEREA T T =G &L
bV E], PTBCEBCE A hR]. [BRRE] [FRITE.
(%]
o MRUE[hSER: [FRENWAAR, EiE R ERHEAR,
o EXNEHE NONAIVY AL Bon B B . BB RAREE, AW,
o KRTHWEIHMM, HSRUGEHET.

f Brother GTX pro FEHaE=S X
BEASHE
OizsAa: B green (0,199,0) EH...
BRCE | 30

R EEHES: @EE O

1 2

I | 1

01234567839 10
e HEAHREE: i E
BFEE

0 10 2 30 )
WA : 1 [s
=E: I | 5
RAELE : I | 5
pA=he i

54-3-2-101234°5
#HE: l | 0
iI@: 1 | 0
=8 1l [0
2aE: i | 0
[ #repTED

ol (R
A

(3) WELTHA FdE].
(%]
e M"GTXPRO File Viewer"#{TJF ARXP SCff /5 Al S AL i B H .
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5-4-1.

PR

MIBHRSY s 10 R IR T ENE K SRR

(%]

o RHUTEAGKHUEAE .

BEEIH

fEFH AR

R

[16x21]

16x21 JEHR

406.4 Z=Kx533.4 =K

[16x18]

16%18 JEHR

406.4 ZKx457.2 2K

[14x16]

14x16 EH

355.6 Zkx406.4 =K

[10x12]

10%12 JEAR

254.0 2Kx304.8 2=k

[7%8]

7x8 JEH

o= FTENEIER
Ex/EE BTRE

[FIRRT:

it 573
1w

BEHRIGE: 1 3 5
vt I

B

FTENRRE: | .1 EE«EB |400'/.

(I aem#TEn
CaesriTen

Oaezei 4T

OfAEMeRe (RETIHERD
\ CI#zeey & SBIRITED

glﬁth
R TENPREMAIEIRGIR T,

| 16621 (406.4x533 4mm)
16¢18 (406.4x457 2mm)
14x16 (355.6x406 4mm) ==
‘ 1012 (254 (x304 8mm)
8 (177.8:203.2nm)

177.8 ZKx203.2 =ZXK

X

REITERE
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5-4-2. EPFEMBMR

AT B A

MBS iR A SR AL &

WEIH i
B+ H ] 1E A ORI LE FATER AR
A SRENE)| RYEH At s, FTE R EEIE.
(NG| TEE&méﬁtﬂw B
[ B Ey 58] FUEH RS, fTEHEARIE.
& FIEEER
gx/Ee EXAE
ERRT: w16 E ET
SRR
s s
BEBRIRE .
i I 5
5
b4 | 3
[ seersEnedTEn
[ &a&551TEn 50
ITENiEhR @) [T
O aeseidTen 50
}i[.;z,l’:.-; ) 20
OfAEHEe(EeTaER)
O &6 5 SWEFTEN VX AT
;g!?!%giﬁm!ﬁéﬂ“ﬁiﬁo
e+ AehE: FE e hRENE HITENF/EES,
RethE: AEHAaehE, {TENEG
(R : fE I e‘mﬂmﬁ«%
MEEHE: JEHRMHE, {TENRG
|
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5-4-3. EFAER

Rt Tt E A Gl St EEAE )G, ERRRAT I Bt s, s S A .

(%]

WRAEEE AN, SERh ISR ] RE SRR

= FTENEEIN
sx/mE EXAE
ERRT: [14x16 v e
ft S5 e+ aeng v]
i Ol © e NS
EIE 1 3 5 7 9 1
e I s
1 2 3 4 5
fTEmdia: [ o gg:mﬁ [400%
(] &aemsRTE
O aesskiTen
TENEPS L) | 20
Oaeseqs47en 10 20 30 4( 50 60
{TENEPS @L): | 0 |
OFRESRE (RETHER
(32289 8 2 BETEN | mEEE

=5t
E; AEEACSRERE, WHEFeThR TR,
185, RIBMAE, STt TR RN B8RP,
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5-4-4. WEAGME

[ st Rt 4 A G aR] s A G, Bor[A G E. [sEDH
Kt NEDt: 1 TIRA SR M. | TR RMEER B ) 7R,

AL, FEREEEFTRY [BESEATH, [AEZEAFIFTRIFIRE A GhRadE,

i FTENEIEIN X

sEx/mE BXAE

EIRRT: S e
Pt 3% 7= D

125t @il O BEHBHIR

(O aems#Ten

ClaesmriTen 10 20
$TENEPS @L):
OaezeidTen o

1TENEPR @2

CIFRFEMERE (RETIBE R
(3289 8 2BETED | mEigE

SEnENE:
ZAF A R-ERBR IR ROEBR R, STRE L ELS
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=5
MA13]2 ik RGB=254 1A E (K. HUK, A ihs g in.
R A @ RFTEIERES, AIHEE[10]~[13],

R EE AR
[1] A 2R B 200%
[2] s 250%
[3] s 300%
[4] O S 350%
[3] O 2 400%
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aenR: 400 %
FIAEMRE: off
F/BEY H SWETEN: off
...
Fenl: 0.97 cc
BEnE: 8.65 cc
TEm: 13k
X4 LLa

100% I

8TE
wae

600%

1 wsaMvk v Ogesng

e
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6-6-2. MR RIATENEHE

CorelDRAW

(1) M FEEFile] > [Print].

(2) FTHH[Colorhz%s, HATLLNIKE.
e %" [Document color]
e [Color conversions]: "Brother GTX PRO"&"Brother GTX PRO FileOutput"
e [Color profile]: [sRGB IEC61966-2.1]
¢ [Rendering intent]: [Relative colorimetric]
Print X
General Color = Composite = Layout  Prepress  1lssue

Color: ® Composite
Separations

Settings: ® Document color

Color proof
Color conversions: Brother GTX pro FileOutput v
Color profile: sRGB IEC61966-2.1 v

V| Preserve pure black

Rendering intent: Relative colorimetric v

The color settings and preview available in this dialog box are set for the Windows
Graphic device printer that you selected on the General tab.

? Print Preview » Print Cancel Apply

(3) FIJF[Generallbr%s, M[Printer]+i%$%"Brother GTX PRO ",

(%]

o HHEENGHI[Printer] 5 E J9"Brother GTX PRO "I, #TEI¥ A%k TEIHL.

Hte 24 K[Printer] 4 & A"Brother GTX PRO FileOutput"iif, $TEI4HE Ll ARXP SUIFHRAE

(4) fE[Preferences] & EITEHINIIRBIRES, % T [PrintP e TEHERI[OK AR T B &R -

(%]

o RTHEWIIRANFE PR E % =54, WEITEHNIERIFET >>P.81"

o BMFERTHOK], FTEMNLHIVEIFARITEN . 4% FHTENBLIAT V2R FAR4T B
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Adobe Photoshop

(1)  MEHF P File]>[Print]. PC —EH FI4T EIFLA"Brother GTX PRO "gi"Brother GTX PRO FileOutputf,
Hehi s B AR
(2) FATLAT®E.
¢ [Color Handling]: [Printer Manages Colors]
e [Rendering Intent]: [Relative Colorimetric]
Photoshop Print Settings X

Printer Setup
Printer Brother GTX4 FileOutput

Copies: 1 Print Settings...

Layout: [y F

Color Management

Printer Profile:
Normal Printing

lendering Intent:  Relative Colorimetric

Description

Position and Size

DArtinn

(3) M[Printer]4i£4%"Brother GTX PRO ".

(%]

o ¥4[Printer] 3£ E N"Brother GTX PRO ", FTENHHEAIEEFTEIHL.

¥ [Printer] 4 & A"Brother GTX PRO FileOutput"fit, FTEIdE LA ARXP SCHHRAT

(4) E[Print Settings]-F i BT EINARENTE T,  mi[Print] A& 4TENEE .

(%]

o SKTHATEWLIRSHFEF IR E ik =54, WEITEINIRSIFET >>P.81"

o M ASi{Print], FTEIHLICIEIFARITEN. # N T EIHLRIFT ENFEEIFAGTTEN

143



FAFTH

©00000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000000

Adobe lllustrator
(1) MR 1E$E[File] >[Print] >[Color Management].
(2) BHATLL T WA

e [Document Profile]: [sRGB IEC61966-2.1]

e [Color Handling]: [Let lllustrator determine colors]

e [Printer Profile]: [sRGB IEC61966-2.1]
e [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: Custom

Printer: Brother GTX pro FleOutput

General

Marks and Bleed
Output

Graphics

Color Management

(3) M[Printer]*i%#£"Brother GTX PRO ",
[Z*%]
o ¥4[Printer] i3 & A"Brother GTX PRO ", FTEIHE K% EITEIHL.
¥ [Printer] 4 & A"Brother GTX PRO FileOutput"fi, FTEIdE LA ARXP SCHHRAT

(4) 7E[Advanced] ¥ BITEINIIREIFEY, sdi[Print] & 54T ENEE .
(%]
o ETATEMNUERAFLTIIRE T, =54, WEITONIREFF >>P.81"
o BMESEPrint], FTEMHIBICIEETIGFTEN. # N HTENHLRIFT ERSLEN TR AR EN
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6-6-3. M USB 7EE2E NITENSHE (ARXP 3Cf4)

(1) Ks USB fH#i &l N ERAE TR AT T 9 USB A7 &34 1«

[HE%]

o NI USB fifikas. I, ATRESBUR.

(E=2

o [iFEZEN2 GB~32 GB AT, iliid FAT32 #%ULi USB f#fkts. ok & Bithae %2 2 ThResok T 32GB (1)
USB 771

o i USB FHifds I NHIEIH 9 ARXP #3(A ARX4 4% :UHIHE

USB i as4E 1

X0038

(2) Ak e RIS, ST @ -

(%]
o REEARP R AHER.

el
TERRES
FTEMMC

EEYTENHGRE
e
2

(3) FHTENRCIEA, T @ -
[5%]

= i
o USBREMIISCIEREIR 3 ). A 4 2N FOIRICrE.

o< IBIFFRF o< IBIFFEF
(3 Sample Folder 0 Sample Folder1

(J Sample Folder? ) O3 Sample Folder2

— Sample Datal.arx4 — Sample Datal.arx4

v2 Sample DataZ2.arxp £ Sample DataZ2.arxp
Sample Data3.arxp Sample Data3.arxp
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() SAREEEDR, T @ -

(3]
o ITENEAHINIRIIE, E20MAE USB fEik#S . S AT RE SEURFEIEIR.
(%]

o IRIEEGEIIIN, EHATREFE L.
o LIAEEEN USB R N ISCIE . =91, KA IR >>P.226"
o  HUAFEHIEHEEM TN, ="8-7. ik RkE >>P211"

Sample Data

B 14 x 16 inch
¢ 5.45cc

HORIEEROK

FTENFZ RN, B P 5 B S e
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6-71. FTEI13k

™

@)

BAATE R

BASOWIRATENZHLINKR, BGERE, 7S, $TEEHIA AT -

FEEIPON 2 7, TRIEIE 2R I ARONT T B (K L AR RS A

(%]

o BT BZATHRREBUT AR, A

o BT HZHIAFREBRT EHRIT, A R

BB RR AR T s B TED ORI, 2 AT BT 46T EN

FTENSERA, REHARRS iR AE U T A AL B, A

(%]

o JEHCRIFTERATHZINS, BIfERL NTEIZEH], QOB R AL RTINS, TITanITEN . E R RIE M TEMHZH.

e &P @ JRFTENRGH .
o EENREACASCTHEREL T, MAHACMEITHE, TREStHRERRET,

IRIRISATEY, FIRNBYEFOFTEIFFAARTHISES BB FTRERR S, RIS THORER, ="8-11. BRI FIFTENS)
fE >>P213"

o HIRGEEREER, FIEIGHAHER R TERE EREEEENEESEEE  BREERENREES , FE4

BITMMRIBER. ="11-1. 2E >>P.292"

6-7-2. ITEIZK

TRAFATEN R, IHTENZ 5K,
(%]

™

(2

IR, MR ORI R -
M BB FTEPHL (¥ L SMMBRIT BN e ] vk BRI, SERRE TREBURHTENS, FeMIERST Enteds . ATEBLER, ARG 24
HERE. =78-16. HIMERITEHSE >>p. 216”

B T AR S EEA T BN, 4% S FTENEAIT 464 TER

ITENSERE, REHARRS S i FE T AT AL L, A 7

(%]

o IBSHURIAEHIFESIN, BIFEZ THTEMEH, (OB RS TNEES), TTETFAGITEN . W EHAEE N TR

e %P @ JEATENHGI -

o BRI PRI TR

o EENREANCASTHIELT, MEHAGCMEITEHR, RSB RET.
RIRISATIN,  FTENMF AT ENTFAG RO 4ES N (A rT feAR . AREARIRIZAT IO B BN, ="8-11. B BRI IFTENS)
fE >>P213"

o IRAGEAUEREIRY, FTHIG AP TR, EREENEENBERERE  BRESERENTERS , EHAF
EITEMRIEBEE, ="11-1. %E >>P292"

SEHEBRITENA BT (T D, FEHTEVE 2 e BT i TR AL
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6-7-3. MBGCRITED

F AT B R B T BV

(%]

o HEMSORAFIITENEERZ W 100 4>, Ftit 800MB, M F-HT ENEE FAamER .

o UIWTHIRE, RHMIRRORAT IR

o MOBEITEMHL B [ A SMMERAT ENEE ] chade B BRI, VAR RGE R T ENThRE . AR E I ERY, TEIRIE TR I E.
="8-16. HEINMIERFTENESE >>P. 2167

(1) MGGk FEH TEI R A -
(%]
o IEIREHT IR I BT BN -

(2) BB TR R BT ENREE, 4% N 3TN A4 TEN
ITENSERE, KEHARES S AR AT AL L, A P
(%]
o IEHURIATHRTRSIN, BIEL THTEMZH], (OB RS TR, TEITFAGITER. W RHAIE N TEEAL

. BT @ JEHTEH.

o  EENEEAL 18CHIET, HAGMEITENN, RS THSRIRIZT.
{RIEIBATH, FTEIR [AIAT ENFFARRT I 4ET I A T e . ARHRIRIS TR ER, ="8-11. W ERIRM T ENZ)
g >>P213"

o HIRAGEAUEREIRY, FTHIG AP RE TR, EREENEENEERERE  BRESERENTERS , EHAF

SITMRIEBEE. ="11-1. 2E >>P292"
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6-8. ITENTL

I RE M TEIURAL TAHUIRAS, R ATIEId F e 1% ST BN T T, A2 T LA A AT ST BRSNS BRI TFA64TER .

6-8-1. TEITRLAIFTENHIET[A]

FYHTEN R TENS RSB, B ol sSs e A SIa], T TEHZ T T B DA T —4TED.
FTENGEAHUEHCN T, et BSCESTi T4, RSSO, FTEIHLEERET E—NMTEIR S AL HN, .
(%]

o WAMETENSER) T MR EICT, KEESHTENRT — T MUBCELERR b, 2RJE% R AT eI

o IEISHIRESATITEINUN, AREFGIL FITENZAH].

IS 1] iR
YT BN A FTENHLETE USB £R45/LAN £R45 Bl T BNt et
FTENJE 1 JE AL E ) FTENTERET FIESUS, EATHEL B0 BIBGEE. 1TEE B3GR ER
H (i SRR BRIRZISHE N A SAEFR LI %, AEATEHUAAA A REAT B s IR I

6-8-2. ITENFFLAHRTIE

TLTENG, FTETFAGI R A R R

FRLIFT EVIS 8] FTENTHARIS 8]
FAAT EP IR ITENSeE e
ITENE A AL E] GG B0 RIBGE . STEYS BB A AL B A i S it
I i SRR F i SRR E e R

(%]
o TRAHTENEEHTENIFAAMIN], FTENZHIPOEINKR.

6-8-3. TLIEITUAITENHIIESL

KALLIEOUN, BUEFL thIciE e e
o JHUAATENRS, RAMRRNT. (Bltn, BLE—JFETHE, JhssiRn D
o JHUGATEINS, FTEONLEBATATEESE. (B, L [ A siMERITEN SR Thag, TR IHERTT BN (EeE -
="8-16. HINMMBRFTENESE >>P. 2167)

6-8-4. EUHITEIFA

TRETEN R ZHTENTFAG ], ATIEIL % R HOH AR T BN L .

I ELh SR FRAHT BN, SR 42 R EBOH A, R RIS B B il SR a3 A AT ENTRA) o
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6-9. MEARESFT

(1) ARFETEIRIE S, R ST .
(%]
o ITEIEIMh SR, 152l
o T hufibihsRnt, T EEERKER.
o HT ARG A LI BRI, IR ERE TR
(%]
o HITUMERARER, RULACHE T ML 20T BV AR (TR .

T il

X0114
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SE S SR s 2B LR A -
o JRIML
I FEE MR [ P PR B8
o HUE
TTENSREE S, BEEfERE.
| GE=9
o IHFERFENE NI MG IS RIS . BRI, T s = .
(%]
o EMATEN, AIREHTURAREEEE .,
o IHTIGIEE TS AU B K E S o
ISR M5 5 FT REFE 2T EN T L.
o WRAEAGERROHRRLIAEGHBCE EEERATENR, WATRES| 0.
UNSR A I BEEAUR it S84 T EDAOST BN (3 o S84 TENROFT DI, M RIAE & SR et
LG, TR AT B R R PR T Bl A T B 5 15t
o IRIATUCEGHEAERERAMSEN T BT AUy R FE TG,

SR RO AR A IR

IR AR BRI A SONbRE, g A% R P R AR AN TS o 5 RS R BN 2 ERUR FEE THRA

[(2%]

o ARHBBEHIOEHURBAERZE, BRI, PR AR E BT . 155 S RS SR B R R I
AL

o MRMETEINGL, WATREA SR, BIE AR IR
JEHFERIATAL B (M A S e

o RN, TERHAMSRERACRIFIN PR ).

o HMEHT TAMERTK IR IED TR, IBFENIER I SR TR UL [FIRS HEACH 8] o

ol i i)
JERNL 180°C (356°F) 35 )
HEA FIRE 160°C (320°F) 34} 30 fb~5 4

T R T MRS, DU R IR R
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B ERLE MR
(1) REfsR. T AMPAR RS BORCE R R AL EIF o aE.
[Z%]
o XTMSREMAIMRINE ='6-10. ERmss >>P151"
o HBIREREA RN .
o INFUEFHAER A RREAUWEARIER, WA TSR BCR I, R R, WA TE B AR RCR I . HEARYE
XA

Z)ID)D)

JEZHL ,
o]

fy’z:‘,\v.’;‘ \ FIESHR

7

\/
JiEENS

Tl
X0115
e E T B e e =
(1) AL MR T ML T a8 e 5
[Z%]
o RTMBERAMRIAME ="6-10. EHHSE >>P151"
o fEEATIUMMARRT, TERAUZE P IR DL SEBRIH SR R R AR
o ESHREREA AR LA U T,
T il liZeshignw iyl
’ )
N TTT L1
( ‘ 4 |
out in
X0116
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NT T RE /| K

AT

A il e PR A AT RE B DIWTHRIR, 1ESERE 5 0 Bh s JRYR T .

AER

KRR, THESAERMAETIR. WRIMETIR, MATseSE82.

TV MR BORL, BRI PGP, RBSERA. SN RESEURTE . Xt

Fiobhs VEREGRIRG AN BTt a . O, TEVEIRL. TUAEEE, POREERA . SR RS A . ARG
B 205, AR

THRCEAE ) LR ARSI .

RIS, SRR B AR TR, USRI B A 2 -

B ATRET R K -

A4, EZ R, S RESEUSE . iXet

THCEAE ) LA AR .

TN R MEAT, RN R A TP AR R A B Sl fae, A A ]
BEA ST

A A R P IR e . R AIRERA D IR, W] RS 3052 7 el

e & op

CIEEHEMR

TEZI TR 15 AT RE S ECANL L B S
TERRAHLET T R 052 8] IS 270 BNt 7300 §E Bl S2 i
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7-1.  ERHATEIR
711, #FER AR

TsTM’EE*)i@@E‘J?Hﬂ%%HE%.N » TR AR
$E=9

o R, BHMERAZKTE. PHE.
o ERAEZERANTEAIHRIMBENIN IC #E.
o fhrEihERI, A IC HERTIEITEN.

% THIR
#rTHhE FE

] |

(1) MSEH PN e ], ma?@o

(2) MIBE] DEEL [HE] LarmEmsame, i @ .
(3) FEASHIMBAEICRIC . ST @ -

[5%]

o MRS TR G, R,

X0391
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(4)  ATTTAbTE I SR G, 22BN RO DIE e 2 -
[E%]
o VHEMERIGRINEYE, LK.
o NTEFIEARIIEE, SRR, KRR RR S AT R
o IEZVERIBEMAINESE CASN RS R REP AR ST AR, BT EIHL S I
o 1.8 LTRSS 1 KH5E.

fiEm fiesk

2
T

éb&E{

T A S

18L

FhTe i SR
1.8L

X0444
(5) FTIFIhRGENEE, AN TIERE R ENA 6 DLEMZIEL.
AN, ANFEFMARIE Y 18 LI,  E e A VS 1R A TS o
[E%])
o T 6 UL EMZIEL.
TS SR e IS 18 L

AN w s oo

X0445

6) TR @Y. smmmamrEET @ -
(%]
o KMFEIMERE LKA AR 5 o
(7) SRR, il 1C HHE T @ -
[#69E]
o K IC HRREMSFE RN TE it SRR TR AL AT R
o KIS IR LB HE RF -
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7-1-2. M RAGAME

T%T@ﬁ*ﬁ@ﬁﬁ‘]?ﬁﬂ%%ﬁﬁﬁ'ﬂﬂ‘ R PONE S

Hh, BT AR HITIE, FIAERN S SR ATE A 2 BB VUE M K. T bE s Emta), BRI F el

k.

(%]

o [EAIBEFEATE KRN, WRESBUTHMMIHAMALZE  STEERASR . FEHRFA TS RSB A EREN, RIMEEAA
TREIIN, thATRER ZSUYEER .

o IHRERAAN T SHLEATHE

o IARAEEREURIERAE AN T i SR AT R, WIRTRESIR AR BT B Bk

[EE]
o R, IERIERALMAGTE. HE.
o ERAZEERKAN T SMBEHTN IC B,
o hrmihERI, A ICHRRTTCIEITED.

BB AR
(H%]
o WEFULINBHEL
T B A0S, DA A IS b R

(1) b TE I S 2 L L
(%]
o ABTIEBERETRN R A ARSI R LA A [ E

(2) VESHBHPLI I BT R
(%]
o BEPHE AR IRIHREh S8 AR B R AN LK PR RE A A AR AL

(3) LR AFAh ST A, TSI T .
[FIFE A 18L b7 Al St R A0Ue], RIS LA TEiie
(e =

o (AR HEEEARR, LMEASEBIEY.

El é?‘/m A - V -7
\\ soew | AT R85

e N

\ - ?\ ElcE

X0418
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N THRITEIR R / 3K dh A A

X0425

(%]
o {EHFFAGMERSE, ANTCEX BRI TRYTEY, FItEE BENERIE R R TRIA
XA AR E AR R R R AN T M, ASREE TR B iARASl,  WATEY).
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SRR SN SRS

% THIR
#rTHhE 58

NEE=

(1) SRR Fo ], a‘ﬁﬂ@o
@ e, i @

(3) AL IC B, wﬁ?@o

(%]
o IMFHNGHBRRBOAFRBUEH ICHE, RERHEHR.

X0391
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(4) AT e SRR A, 2B P AR i 2 -
[EZ]
o VsERERIINENS, DL ERAER .
o NTMEFILRIIEIE, EHIRAEEAN R, KRR RS P AT R
o IEZIMERIBEMAIANTERE AN T REP A ARG AR R, P EET B LB
o 1.8 LN TEH I 1 UHI5E.

pIE N JiEZE
é
- %
- =g
VL
7 S EL SRS @
1.8L 18L
v
X0444
(5) FIHFhEEEER T, A RIHSRE R RA 6 DL EINZIEEL.
Tk ANFERTMEECA 18 LB, IS HBUE I I HE EAR S
[FE%]
o B 6 LR,
078 I SR TR M ERIE 18 L
1.8L
i
TS
X0446

6) TR @ smmmimiEET @
(%]
o fhrEihER/E IO SR EE I -
(7) SRR, il 1C HHE T @ -
[#0E]
o K IC MRS AN TE it SRR PR A AT R
o KNGS MUE KT IS MIRFF .
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NTHHPRATENE /I 75 i

7-1-3. ERMEHRGET T

P RAE O, TR,
(1) MRS > B S 0, Ih T @ -
(2) SEHBMILH, T @

TR T
?ﬁiﬂﬁﬁ§ﬁfﬂ¢
MR hEEE

(3) HURGEE, BRSO, T @ -
[%%]
o [AMHETIMIMET R, IR, HETERIE DL S e

(4) TERATIER. HHR
=7-1-4, JEEIERAR IR, HEGERE UdE e >>P.161"
="7-1-5. BEHUF IR >>P.173"
="7-1-6. AR >>PA75"
="7-1-8. R MFILIER >>P.182"
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714, FEEBETIR. BIR. HESERNE DR SR

ek FRoRE RS, B TER.
YEP AT, PTRES FEGT O R S5 ST EI R Aaa 5 | R T R R4
0%

TEIIE=TR/EIAR
BTN ARE 8]

[ BN

(1) HERBEMI AR Ry R T, ST, TS
(2) MSESE RS> R S, 0T @ -
(3) HHEEE N, FET @
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(%]

o v @R, EEORHRS. Bt
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(5) FTUTRUERDE, AWM. B, HE IR AR R
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